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Proof of play is the ability to generate a report of which advertisements were played during an event. 
Once a proof-of-play file has been set up, Cisco StadiumVision Director collects and collates 
proof-of-play data from the Cisco DMPs and displays it in a proof-of-play report on the Control Panel. 
You can export the data to a Tab Separated Value (TSV) file and then use a spreadsheet application such 
as Microsoft Excel to generate reports from these TSV files.

This document describes how to enable proof of play, create tags for proof of play content, generate 
reports, export TSV files, and troubleshoot proof of play processing.

Contents
• Prerequisites for Proof of Play, page 1

• Restrictions for Proof of Play, page 2

• Information About Proof of Play, page 2

• How to Configure Proof of Play, page 10

• How to Work With Proof of Play Reports, page 18

• Cleaning Up Proof of Play Data, page 23

• Troubleshooting Proof of Play, page 25

• Feature Information for Cisco StadiumVision Director Server Proof of Play, page 25

Prerequisites for Proof of Play
Before you use Proof of Play, be sure that the following requirements are met:

• You have a Cisco StadiumVision Director user account that is configured for an administrator role.

• Your content meets the requirements for support of proof of play records. See also the “Restrictions 
for Proof of Play” section on page 2.
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Restrictions for Proof of Play
When using Cisco StadiumVision Director Proof of Play, consider the following restrictions:

• Content placed in the first event state might not appear in proof of play records. Therefore, it is a 
good idea to have the first state in the event script be an “idle state” that serves the sole purpose of 
allowing the DMPs to start.

• When you use Proof of Play content in your playlist, and especially when your PoP content is 
included near or up to the end of the playlist, you should define a final script state (without any PoP 
content) that runs for at least 60 seconds so that all PoP data has time to be captured by Cisco 
StadiumVision Director. This last event state is commonly set up to turn off the displays in the 
venue.

• In previous releases of Cisco StadiumVision, proof of play for playlists of two items did not function 
as expected—this has been corrected in Cisco StadiumVision Release 2.4. However, there are some 
caveats for playlists that have items with zero duration which might still affect proof of play (see the 
“Limitations and Restrictions” section of the Release Notes for Cisco StadiumVision Director 
Release 2.4). Otherwise, typical playlists for one or more items works as expected for proof of play.

• Cisco StadiumVision Director is unable to generate proof of play for an event if proof of play is 
turned on for a Dynamic Menu Board playlist. Therefore, before generating a proof of play report, 
be sure to turn off proof of play for all Dynamic Menu Board playlists.

• After the Flash template automatically restarts, a script must run for a minimum of 90 seconds for 
proof of play data to be available. It can take 50 seconds to one minute for the Flash to completely 
restart.

Information About Proof of Play
This section includes the following topics:

• Change Summary, page 2

• Content Naming and Tagging, page 4

• Data Storage, page 4

• Data Backup, page 5

• Summary Proof of Play Reporting, page 5

• TSV File Format, page 6

• Proof of Play Reports, page 6

• Proof of Play Workflow Overview, page 9

• Proof of Play Interface Overview, page 9

Change Summary
The following changes are made to proof of play support in Cisco StadiumVision Director Release 2.4:

• The exported data files were changed from comma-delimited to tab-delimited format for support of 
internationalization (i18N). 

http://www.cisco.com/en/US/docs/Sports_Entertainment/StadiumVision/Director/release/notes/2_4/SV_Director_Relnotes_2_4.html
http://www.cisco.com/en/US/docs/Sports_Entertainment/StadiumVision/Director/release/notes/2_4/SV_Director_Relnotes_2_4.html
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Note The file names continue to use the .csv file extention, but the data is in Tab Separated Values 
(TSV) format.

• The names of the supported file types have been changed from “Generic” to “Detailed” and from 
“KORE” to “Summary.”

• The following file names have been changed:

– detailed.csv (renamed from genData.csv for the generic report in prior releases)

– summary.csv (renamed from koreData.csv for the KORE report in prior releases)

• The raw proof of play data gathered from devices is stored in the /var/sv/pofp/raw directory (was 
/var/sv/pofp/dbDump in prior releases).

• The following register changes have been made:

– EnableProofOfPlay—Set to a value of “true,” which enables proof of play globally for the 
system by default. 

– PofPDaysToKeep—Obsolete.

• To support localization, the column names have been changed to the format “locale_name (English 
Name).”

• Table 1 describes changes made to some of the proof of play report column headings by report type 
using the English version of the locale headings:

Note When you have installed a supported language pack for Cisco StadiumVision Director, the heading name 
in the “locale_name” portion of the column heading will be shown in that language.

Table 1 Proof of Play Report Column Heading Changes in Release 2.4

Column Heading in Release 2.3 
and Earlier Releases

Column Heading in Release 2.4: 
locale_name (English Name) Report Type

Cluster ID Cluster ID(Cluster_ID) detailed

Content Tags_PoP Content Tags_PoP(Content_Tags_PoP) detailed, summary

Device Count Device Count(Device_count) summary

Device Name Device Name(Device_Name) detailed

Event Date Event Date(Event_Date) detailed, summary

MAC Address MAC(MAC) detailed

Playlist Name Playlist Name(Playlist_Name) detailed, summary

Playlist Number Playlist Number(Playlist_Number) detailed

PlaylistNum Playlist Number(Playlist_Number) summary

Receive Time Receive Time(Receive_Time) detailed

Script Name Script Name(Script_Name) detailed, summary

Seq Number Seq Number(Seq_Number) detailed

SeqNum Seq Number(Seq_Number) summary

Spot ID Spot ID(Spot_ID) detailed
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Content Naming and Tagging
Use of a consistent naming strategy makes it easier to generate and manage reports. For example, 
prefixing region 2 content file names with “R2” (for example, R2_filename.jpg) allows you to generate 
reports on region 2 content since filters can be applied to look for “R2” at the head of the string. Other 
types of content should have unique identifiers like “FS” for full screen content, and so on.

Additionally, associating proof of play tags to content provides excellent metrics for reporting and 
filtering. Tag names are free-form so they can reflect an advertiser account number, campaign identifier, 
or other reporting metric. These tags will appear in the summary TSV file. For more information about 
tagging and the naming guidelines for tags, see the “Creating Tags for Content in Proof of Play Records” 
section on page 14.

Naming of groups and zones is equally important as they will be directly reflected in the report. A zone 
name of “Concourses” with group names of “Main Hall” and “Section 101” make for easier reading 
within the report. This also makes it possible to generate a useful proof of play report without detailed 
knowledge of how the system is configured.

Data Storage
StadiumVision gathers logs from all Cisco DMPs after the event. These logs contain, among other things, 
the content that was played during the event and when it was played for example, before the event, during 
the event, and after the event.

All proof of play data files are stored in the /var/sv/pofp/data/"script cookie" directory, with the 
following names:

• detailed.csv (renamed from genData.csv in prior releases)

• summary.csv (renamed from koreData.csv in prior releases)

• process.log  

• rawData.csv  

• snapshot.XML  

• states.XML

Note Although the file names use the .csv extension, the default format uses a tab delimiter for data within the 
file in Cisco StadiumVision Director Release 2.4.

Raw Data Files

The raw proof of play data gathered from devices is stored in the /var/sv/pofp/raw directory. 

State Name State Name(State_Name) detailed, summary

State Start State Start(State_Start) detailed, summary

Time Played Time Played(Time_Played) detailed, summary

Table 1 Proof of Play Report Column Heading Changes in Release 2.4 (continued)

Column Heading in Release 2.3 
and Earlier Releases

Column Heading in Release 2.4: 
locale_name (English Name) Report Type
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Note The files in this directory are removed from the disk after 60 days.

Data Backup

Caution Proof of play raw data is not part of the backup process. Only proof of play report data that has been 
generated to the /var/sv/pofp/data directory (indicated by the green dot icon beside the script) is backed 
up. Therefore, it is very important that you transfer PoP messages from the raw data directory to 
"data/<cookie>" directory as indicated by a green dot next to the event, before 60 days of the event, after 
which time PoP messages in the raw directory will be deleted.

Summary Proof of Play Reporting
This section includes information about the Summary type of proof of play reports:

• Compatibility for KORE Processing, page 5

• Working With Summary Data, page 5

Compatibility for KORE Processing

To support KORE data processing, Cisco StadiumVision Director aggregates proof of play data across 
DMPs and generates reports that show information based on total playout per sponsor rather than 
individual playouts per DMP.

Because Cisco StadiumVision Director exports data in TSV format as the default for release 2.4, you 
will need to either change the Cisco StadiumVision Director default configuration for proof-of-play 
reports, or open the data in a spreadsheet application and save it as CSV for use by KORE. For more 
information, see the “TSV File Format” section on page 6.

Note Localization data will not display well in CSV format.

Working With Summary Data

The summary file is the result of post processing the main proof of play file and condensing it by 
collapsing multiple entries with the same time played stamp into a single record or row. Once the data 
set is in this format, it is much more manageable (around 5-10 MB for the average event) and can be 
further manipulated in Microsoft Excel.

The advantage of using desktop software like Microsoft Excel is that it provides the ability to share, 
modify and distribute the information to others depending on their needs. By leveraging the inherent 
functionality of the Pivot Table feature in Excel, many views into the summary TSV data can be 
accomplished. For example you can set filters to view:

• Only the game states that represent the time period of interest.

• When and where content played by content file name and any included tags.

• The total number of plays for a piece of content throughout the venue.
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• The total number of plays for a piece of content by specific Group or Zone association.

• The cumulative time a piece of content was displayed throughout the venue.

• The cumulative time a piece of content was displayed by a specific Group or Zone association.

TSV File Format
Beginning in Cisco StadiumVision Director Release 2.4, the format of the data exported for proof of play 
reports is formatted as tab separated values rather than comma separated values (CSVs) to support 
internationalization (i18N). 

Note Although the default delimiter for data within the file is a tab rather than a comma, the file name still 
uses the .csv extension in the file name.

If you are using a data application (such as KORE) that requires a comma-delimited format, then you 
can change a register in Cisco StadiumVision Director to set a comma delimiter as the default format for 
proof of play reports. For more information, see the “Changing the Register to Support 
Comma-Delimited Data Format” section on page 11.

You can also open the file in a spreadsheet as a tab-delimited file, and then save the data as a CSV file 
for use in another application.

Note Localization data will not display well in CSV format.

Proof of Play Reports

Note In Cisco StadiumVision Director Release 2.4, the names of the supported file types have been changed 
from “Generic” to “Detailed” and from “KORE” to “Summary.”

Cisco StadiumVision Director supports two types of file reports:

• Detailed—Creates one record for each playlist that was played on a DMP.

If a single playlist was played across 20 DMPs, the generic TSV file will show an entry for each 
DMP.

• Summary—Aggregates proof of play data across DMPs and generates reports that show information 
based on total playout per sponsor, rather than individual playouts per DMP.

If a single playlist was played across 20 DMPs, the file will show only one entry, and the Device 
Count field displays the number of DMPs that played that advertisement.
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Report Fields for a Detailed Proof of Play File

Figure 1 shows an example of the output format for a detailed proof of play report.

Figure 1 Sample Detailed Proof of Play File

Table 2 describes the fields in a generic proof of play report.

Report Fields for a Summary Proof of Play File

Figure 2 shows an example of the output format for a summary proof of play report.

Table 2 Detailed Proof of Play Report Field Descriptions

Field Description

Event_Date Date of event.

State_Start Timestamp for the start of the event.

Script_Name Name of the script that generated the PoP report.

MAC MAC address for the DMP that played the content.

Device_Name Name of the DMP.

Zone Zone in which the DMP belongs.

Group Group in which the DMP belongs.

State_Name Event script state when the ad played.

Action Commands to the DMP attached display (reserved).

Content File name of the content.

Playlist_Name Name of playlist for the content.

Time_Played Length of time the ad played out.

Content_Tags_PoP Content tags assigned to the content.

Airtime Actual time that the ad played out.

Receive_Time Interpolated airtime timestamp by using received time (obsolete)

Region Region info in each record of individual content play-out TemplateName plus 
RegionName.

Playlist_Number Item number in the playlist.

Seq_Number Sequence number beginning at event start increment by ad play.

Cluster_ID Identifies the cluster of DMPs that are showing the same screen (internal use 
only).

Spot_ID For internal use only.
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Figure 2 Sample Summary Proof of Play File

Table 3 describes the fields in a Summary proof of play report.

Table 3 Summary Proof of Play Field Descriptions

Field Description

Content File name of the content.

Event_Date Date of event.

State_Start Timestamp for the start of the event.

Script_Name Name of event script that played.

Device_Count Number of DMPs on which the content was played.

Group Group in which the DMP belongs.

Zone Zone in which the DMP belongs.

State_Name Name of the event state that was active when the content was displayed.

Action Commands to the DMP attached display (reserved).

Playlist_Name Name of the content playlist.

Time_Played How long the content played.

Content_Tags_PoP Tags assigned to the content.

Airtime Actual time that the ad played out.

Receive_Time Interpolated airtime timestamp by using received time (obsolete).

Region Region of the screen template where the content played.

Playlist_Number Item number in the playlist.

Seq_Number Sequence number beginning at event start increment by ad play.
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Proof of Play Workflow Overview
Figure 3 shows the timeline for the proof of play workflow from preparing the playlists to downloading 
the final reports.

Figure 3 Timeline for Proof of Play Workflow

Proof of Play Interface Overview
The Proof of Play screen in the Cisco StadiumVision Control Panel displays the status of the collection 
of data required to demonstrate proof of play. Each entry in the window represents an event.

The Proof of Play screen displays the event name, the start and end time of the event, whether the event 
has finished, and whether the raw data was converted to a TSV file (Figure 4). 
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Figure 4 Proof of Play Screen

Table 4 describes the icons used to display the status of proof of play data for scripts:

How to Configure Proof of Play
This section includes the following tasks:

• Changing the Register to Support Comma-Delimited Data Format, page 11 (optional)

• Enabling Proof of Play, page 11 (required)

• Creating Tags for Content in Proof of Play Records, page 14 (optional)

• Generating a Proof of Play Report, page 16 (required)

• Downloading Proof of Play Reports, page 17 (required)

Table 4 Script Status Icons for Proof of Play

Icon Description

Indicates that proof of play raw data is available for the script and a report can be generated.

Indicates that the raw data has been generated into a TSV report file and is ready for download.
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Changing the Register to Support Comma-Delimited Data Format
Be default, Cisco StadiumVision Director Release 2.4 exports data in tab-delimited format even though 
the filenames still use the .csv extension. If you have other data application requirements where 
comma-delimited values must be supported, you can change the register to support comma-delimited 
format globally in Cisco StadiumVision Director.

To change the register to support comma-delimited data format, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

The Cisco StadiumVision Management Dashboard is opened in a new window.

Step 3 From the Dashboard drawers, select Tools > Advanced > Registry.

Step 4 In the Registry Data box, go to the “pop.useCommaDelimiter” register.

Step 5 If the value is “false” (default), select the box and type true.

Step 6 Click Apply.

Enabling Proof of Play
This section includes the following topics:

• Enabling Proof of Play Globally, page 11 (as required)

• Enabling a DMP to Generate Proof of Play Messages, page 12 (required)

• Enabling Proof of Play for a Playlist, page 12 (as required)

• Enabling Proof of Play for a Script, page 13 (required)

Enabling Proof of Play Globally

By default in Cisco StadiumVision Director Release 2.4, proof of play support is enabled globally for 
the system with the EnableProofOfPlay register set to a value of “true.” If this register has been changed 
from the default, then you need to enable proof of play globally.

To enable proof of play globally in Cisco StadiumVision Director, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

The Cisco StadiumVision Management Dashboard is opened in a new window.

Step 3 From the Dashboard drawers, select Tools > Advanced > Registry.

Step 4 In the Registry Data box, go to the EnableProofOfPlay register.

Step 5 If the value is “false,” select the box and type true.

Step 6 Click Apply.
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Step 7 Restart Cisco StadiumVision Director.

Enabling a DMP to Generate Proof of Play Messages

To use Proof of Play, you need to enable the Syslog for the DMP and also set the Syslog Collector IP 
Address. This address is typically the IP address of Cisco StadiumVision Director. By default, Syslog is 
disabled.

To verify DMP configuration for proof of play messages, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

The Cisco StadiumVision Management Dashboard is opened in a new window.

Step 3 From the Dashboard drawers, select Monitor and Status > All Devices.

Step 4 Select a DMP from the device list.

Step 5 At the bottom of the box, click the Settings tab.

Step 6 To view the current syslog configuration for the selected DMP, click Syslog.

For proof of play support, the configuration should be “Enabled” and the IP address should match the IP 
address of Cisco StadiumVision Director.

To enable a DMP to generate proof of play messages, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

The Cisco StadiumVision Management Dashboard is opened in a new window.

Step 3 From the Dashboard drawers, select DMP and TV Controls > DMP Commands > Update MIB.

Step 4 In the Update MIB command parameters box, add the following Name:Pair values:

• init.syslog: on

• init.syslog_collector: <IP address of Cisco StadiumVision Director server>

For more information about updating MIB settings, see the Cisco StadiumVision Management 
Dashboard Device Configuration Commands guide.

Step 5 Select the checkboxes for the DMPs that you want to enable.

Step 6 Click the play button to send the command to the selected DMPs.

Step 7 Verify the DMP configuration to see that the appropriate values are set.

Enabling Proof of Play for a Playlist

Proof of play for each playlist is enabled by default. If the playlist default has been changed, you need 
to re-enable it to support proof of play.

http://www.cisco.com/en/US/docs/Sports_Entertainment/Management_Dashboard_Docs/Device_Configuration_Rev0.pdf
http://www.cisco.com/en/US/docs/Sports_Entertainment/Management_Dashboard_Docs/Device_Configuration_Rev0.pdf
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To enable proof of play for a playlist, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Control Panel.

The Cisco StadiumVision Control Panel is opened in a new window.

Step 3 Click Content.

Step 4 Select the playlist that you want to enable.

Step 5 Select Yes for the “Enable Proof of Play” setting, as shown in the following example:

Step 6 Click Update.

To support proof of play for a playlist, the associated script must also be enabled for proof of play. For 
more information, see the “Enabling Proof of Play for a Script” section on page 13.

Enabling Proof of Play for a Script

To limit the amount of data gathered by Cisco StadiumVision Director, proof of play is enabled by 
default for each playlist, but it is disabled for event scripts. To generate proof of play data, you must 
enable it at both levels. 

For more information about playlist proof of play, see the “Enabling Proof of Play for a Playlist” section 
on page 12.

To enable proof of play for a script, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Control Panel.

The Cisco StadiumVision Control Panel is opened in a new window.

Step 3 Click Control.
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Step 4 Select the script that you want to enable and click Start, as shown in the following example:

Step 5 In the Start Script dialog box, select Yes for the “Proof of Play” setting, as shown in the following 
example:

Step 6 Click Start.

Creating Tags for Content in Proof of Play Records 
Creating tags for content in proof of play records allows you to attach a label to a proof of play record 
that can be used to identify that record. For example, you can tag the records with a label that identifies 
the advertiser or sponsor.

Guidelines

Tags must be created according to the following guidelines:

• The name uses the following naming convention: <tag name>_PoP, where <tag name> is the name 
for your proof of play label, and the “_PoP” suffix is required to designate the label for proof of play 
processing.

Note The “_PoP” suffix does not appear in any proof of play reports. Only the <tag name> is shown.
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• The following characters are not supported in tag names: / ? < > \ : * | " 

• Content in multiple playlists can use the same tag. The number of playlists that have content 
assigned to a tag displays under the # column in the Content Navigation window next to the tag 
name. 

Tip You can display the playlists that have content assigned to a tag, by clicking the tag name in the 
Content Navigation box.

To create tags for proof of play records, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Control Panel.

The Cisco StadiumVision Control Panel is opened in a new window.

Step 3 Click Content.

Step 4 In the Playlist box, select the playlist that has the content that you want to tag.

Step 5 In the Content Navigation box, click the arrow next to the All Content folder to display its sub-folders.

Step 6 Click the arrow next to the By Tag folder to open it.

Step 7 Click the Add New Tag icon (folder with green plus sign), as shown in the following example:

A New Tag entry displays under the By Tag folder.

Step 8 Type a name according to the guidelines for proof of play tags. 

Tip Be sure to include the “_PoP” suffix in your tag name.

Step 9 From the Playlist items window, click and drag the content you want to assign onto the tag you just 
created in the Content Navigation window, as shown in the following example:
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The content in the playlist is now labeled with the tag and the number in the # column increments.

Generating a Proof of Play Report
A green status icon is displayed beside the script name when proof of play raw data is available for report 
generation.

Guidelines 

Before you generate a proof of play report, consider the following guidelines:

• It is recommended that you generate Proof of Play reports within 14 days of an event.

• Proof of play records are not available until the script completes.

• While the proof of play report is processing, there is a delay between the end of an event and the 
availability of the reports in the Proof of Play screen. Click the refresh button before generating and 
viewing a proof of play report to be sure the latest report status is displayed. 

• Depending upon the amount of data you have in the script, it may take from 10 seconds to several 
minutes to generate the report. 

• For zero-duration non-video items in a playlist, the proof of play record will show the airtime when 
the item started to play and the Duration as 0 (zero).

• Cisco StadiumVision Director is unable to generate proof of play for an event if proof of play is 
turned on for a Dynamic Menu Board playlist. Therefore, before generating a proof of play report, 
be sure to turn off proof of play for all Dynamic Menu Board playlists.

To generate a proof of play report, complete the following steps:

Step 1 From the Cisco StadiumVision Control Panel, click Setup > Proof of Play, as shown in the following 
example:
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Step 2 Select an event script with a green status icon indicating that proof of play raw data is available.

Step 3 Click Generate Report.

The date and time of the report generation will display in the Last Report Creation column. Also, the 
Generate Report icon will display in the Status column while the file is being generated.

For long events (several hours), it may take a few moments to finish compiling the report. Click Refresh 
to get the latest update.

Downloading Proof of Play Reports
A yellow report status icon is displayed beside the script name when proof of play raw data has been 
generated into a TSV report file and is ready for download.

Note In Cisco StadiumVision Director Release 2.4, proof of play reports use tab-delimited format but still use 
the .csv file extension. 

To download proof of play reports, complete the following steps:

Step 1 From the Cisco StadiumVision Control Panel, click Setup > Proof of Play.

Step 2 Click the yellow report icon beside the script whose proof of play report has been generated, and that 
you want to download.

Step 3 In the Proof of Play report generation confirmation box, click Yes.
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Step 4 In the script report selection dialog, select the checkbox for the type of report that you want to download 
and click Get as shown in the following example. 

Tip You can select both Detailed and Summary report types at the same time. 

Step 5 In the “Select location for download” dialog box, select the location and file name that you want to use 
to save the Detailed report. Click Save.

If you have downloaded more than one report type, the Detailed report will be downloaded first and then 
a dialog box will appear for you to confirm download of the Summary report.

Step 6 Click OK when prompted to download the next file:

Step 7 In the “Select location for download” dialog box, select the location and file name that you want to use 
to save the Summary report. Click Save.

Step 8 Go to your local drive, navigate to the location where you saved the reports, and open the tab-delimited 
files with .csv extension in Microsoft Excel. 

For information about how to open these tab-delimited .csv files in Microsoft Excel, see the “Converting 
a Tab-Delimited Proof of Play Report to Columns in Microsoft Excel” section on page 19.

How to Work With Proof of Play Reports
This section includes the following tasks:

• Converting a Tab-Delimited Proof of Play Report to Columns in Microsoft Excel, page 19

• Working With Pivot Tables, page 19
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Converting a Tab-Delimited Proof of Play Report to Columns in Microsoft Excel

To convert a tab-delimited proof of play report to columns in Microsoft Excel, complete the following steps:

Step 1 Open the .csv proof of play report file in Microsoft Excel.

Step 2 Click the top of the first column of data to select that column of cells.

Step 3 From the menu bar, click the Data tab.

Step 4 Click Text to Columns.

The Convert Text to Columns Wizard - Step 1 of 3 dialog box opens.

Step 5 With the Delimited option selected (default), click Next.

The Convert Text to Columns Wizard - Step 2 of 3 dialog box opens.

Step 6 With the Tab checkbox selected in the Delimiters box (default), click Next.

The Convert Text to Columns Wizard - Step 3 of 3 dialog box opens .

Step 7 With the General checkbox selected in the Column Data Format box (default), click Finish.

Working With Pivot Tables
This section describes some advanced reporting features that you can use to work with your proof of play 
data in Pivot Tables in Microsoft Excel.

It includes the following sections:

• Generating Pivot Table Reports, page 19

• Applying Filters to Pivot Tables, page 20

Generating Pivot Table Reports

To extract some meaningful information from the proof of play data, you can create a PivotTable® report 
in Microsoft® Excel. A PivotTable is an interactive table that automatically extracts, organizes, and 
summarizes your data. You can control how Microsoft Excel summarizes the data—for example, by sum, 
average, or count-without entering a single formula. 

In a PivotTable report, you can quickly:

• Add or remove categories of data.

• Rearrange the data.

• View a subset of the data.

• Show the details you want.

The example_pivot.xlsx at the link below provides an example of a proof of play file that was created 
using the PivotTable® report functionality in Microsoft® Excel: 

https://dl.dropboxusercontent.com/u/15928784/PoP/example_pivot.xlsx

https://dl.dropboxusercontent.com/u/15928784/PoP/example_pivot.xlsx
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When you open the example_pivot.xlsx file, there are four tabs:

• Total Plays in Venue tab—Displays a basic play count of each ad listed by content filename and any 
associated content tags, detailed by group and zone.

• Summarized Play Time tab—Adds a “Played …” column to each group and zone. This column takes 
the number of plays and multiplies it by the length of time the content played to establish a total 
amount of time the content aired per group and zone.

• Content Time Stamps tab—Lists all the timestamps of proof of play per content filename.

• Example Data Set tab—Default view which shows the entire proof of play data set. 

Note The sample data in this file is from an earlier Cisco StadiumVision Director release.

Applying Filters to Pivot Tables

This section describes how you can adjust the proof of play reporting view by applying filters to a 
PivotTable. It includes the following sections:

• Timestamp Filtering, page 20

• Content Filtering, page 21

• Group and Zone Filtering, page 21

Timestamp Filtering

Proof of play reporting starts when the event script begins—usually before the event—and ends well 
after the event. Therefore, you might need to make some adjustments to the data to retrieve an accurate 
accounting of plays during the actual event versus the timeframe the event script was running. You can 
do this by setting a filter in the PivotTable so that the proof of play report displays only proof of play 
data for content that displayed during the actual event. In the example_pivot.xlsx file, you can set this 
filter in cell B2.

In Figure 5, the filter is has been adjusted to remove play information outside the duration of the game. 
Clearing the “Daily” checkbox for the event script activities causes matching proof of play entries to 
drop from the report.

Figure 5 Timestamp Filtering Example
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Content Filtering

In the example_pivot.xlsx file, cell A7 contains a content filter to trim the entire list of content filenames 
to just the “what” items you are interested in. Individual content items can be selected for the report, or 
a standing pattern matching filter can be established for the report.

In this example, the content filenames that start with “R2” detail the region 2 advertising content. By 
setting up a “Begins With” filter in the “By label:” filter space with a value of “R2_P,” the report will 
list only region 2 content. In this example, the region 2 content is the team's self-promotion 
advertisements.

Figure 6 Content Filtering Example

Group and Zone Filtering

In the example_pivot.xlsx file, cell B4 contains the Group and Zone filter. This filter can have two 
different standing sets of matches to truly refine the “where” of the reporting. They can be used 
singularly or in combination to refine the detail of the report.

Choose Zone from the “Select field” pull down menu to set a filter that displays only the zones of interest 
in the report. If you check only “Concourses,” all other zones in the data set will not be listed in the 
report.

Choose Group from the “Select field” pull down menu to set a separate filter that displays a subset of 
the concourse groups of interest in the report. The Groups filter is used in conjunction with the Zones 
filter.
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Figure 7 Group and Zone Filtering Example

Displaying Proof of Play Data in Seconds

To display proof of play data in seconds, complete the following steps:

Step 1 Copy data from the new report (your_summary_report.csv) to the example worksheet containing the 
PivotTables (example_pivot.xlsx):

a. Open the example PivotTable file named example_pivot.xlsx.

b. Open the new data file your_summary_report.csv.

c. Right-click on the your_summary_report.csv tab in the same window and choose “Move or 
Copy…”. The Move or Copy dialog box displays:

d. In the To book: drop down box, select example_pivot.xlsx.

e. Select the Create a copy checkbox and click OK.

Step 2 Find the last cell data in the your_summary_report.csv tab in the example _pivot.xlsx file:

a. In the example _pivot.xlsx window with the your_summary_report.csv tab being shown, scroll down 
to the last row of data. The column will be “Q.” (CTL+q is the shortcut).

b. Locate the last row that contains data and make note of it. In this example, it is 28263.

Step 3 Reset the PivotTable data range to the new sheet, by completing the following steps:

a. In the example _pivot.xlsx window click the desired tab: Total Plays in Venue, Summarized Play 
Time, or Content Time Stamps.
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b. Select the rows that you want to include in the PivotTable. This updates the Microsoft Excel toolbar.

c. Select Insert > PivotTable from the tool bar. The Data > PivotTable toolset displays in the ribbon 
menu:

d. Click on the “Change Source” tool in the ribbon. The Change PivotTable Data Source dialog box 
displays. 

Note The information displayed in the dialog box will be incorrect as it will reference the Example 
Data Set tab.

e. Type the Location for the data set. Follow this string format with the tab that contains the data set 
and the row value obtained in Step 2b:

'your_summary_report.csv'!$A$1:$Q$28263

f. Click OK.

Step 4 Repeat Step 3 to update the other sheets within the PivotTable file.

Step 5 Save the modified template example_pivot.xlsx file as a .xlsx formatted file with a new name so that you 
do not overwrite the example.

Step 6 You can delete the sample Example Data Set tab to reduce the file size. Simply right click on the tab and 
choose Delete.

Cleaning Up Proof of Play Data
You should clean up proof of play data at the end of the season, or at another time when it is appropriate 
to remove event-related proof of play data from Cisco StadiumVision Director to help maintain the 
availability of your server storage.

This section includes the following tasks:

• Removing Proof of Play Data in the Disk Directories, page 24

• Removing Proof of Play Entries From the Control Panel, page 24
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Removing Proof of Play Data in the Disk Directories

To remove proof of play data in the disk directories, complete the following steps: 

Step 1 Clean up proof of play data in the disk directories by referring to Table 5, which describes the directories 
where proof of play data is stored and can be removed.

Removing Proof of Play Entries From the Control Panel
To save disk space on the server, you can periodically remove old proof of play entries that are no longer 
needed. The delete operation will fail if you attempt to remove a proof of play entry while an event script 
is running or while a TSV report is processing; however, if you delete an entry before generating the raw 
data into a report, all of the proof-of-play data will be lost.

Caution Removing proof of play entries is irreversible and must be executed with caution. 

To remove proof of play entries from the Control Panel, complete the following steps:

Step 1 From the Cisco StadiumVision Control Panel, click Setup > Proof of Play.

Step 2 Select the script proof of play entry that you want to remove.

Step 3 Click Delete.

Table 5 Disk Directories for Proof of Play Data

Directory Description

/var/sv/pofp/data This is the actual data for each game. You might want to keep a backup copy.

/var/sv/pofp/raw This is raw files from devices and does not need to be saved. 

Caution Do not delete the directory itself.



 

Cisco StadiumVision Director Proof of Play
  Troubleshooting Proof of Play

25
 

Troubleshooting Proof of Play
This section provides information to help troubleshoot proof of play operations in Cisco StadiumVision 
Director.

It includes the following section:

• Registers for Proof of Play, page 25

Registers for Proof of Play
Table 6 describes the Cisco StadiumVision Director registers related to proof of play and their default 
values.

Feature Information for Cisco StadiumVision Director Server 
Proof of Play

Table 7 lists the release history for this feature.

Table 6 List of Related Registers for Proof of Play

Register Description

EnableProofOfPlay Enables the proof of play module. Requires restart tomcat for changes 
to take effect. 

pop.tool Link to the external report processing tool. 

pop.useCommaDelimiter Specifies whether a comma or tab delimiter is used to separate the raw 
proof of play data. The default is false, meaning that tab-delimited 
format is used.

Table 7 Feature Information for Cisco StadiumVision Director Server Redundancy

Date Releases Feature Information

November 23, 
2015

All releases The following changes were made:

• The link to the example_pivot_table is updated.

• Topics for the example_min_pivot spreadsheet are 
removed because they were only created in support of 
Cisco StadiumVision Director Release 2.3.

August 5, 2014 Release 3.2.0-518 
(SP1)

Clarified guideline about the use of the last event state to 
allow full processing of the PoP content in the “Restrictions 
for Proof of Play” section on page 2.

August 28, 2013 Release 3.1.0-787 Added restriction for the minimum script runtime of 90 
seconds for proof of play data to be available.

November 4, 2011 Release 2.4.0-147 Initial release for Cisco StadiumVision Director Release 2.4. 
For a list of changes in this release, see the “Change 
Summary” section on page 2.
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